Introduction to Payroll Data

in Oracle Discoverer
May 2015

The Office of Management and Budget (OMB) has worked with Accounts & Control and the
Division of Information Technology (DolT) to provide agency financial staff with accessto agency
payroll data through Oracle Discoverer, a web-based analytics tool. OMB has enhanced its
efforts to review overtime and other payroll-related expenditures and expects that Discoverer
will help agency financial staff better manage personnel expenditures.

OMB prepared this brief overview to help agencies access Discoverer, run basic queries, and
perform data analysis.

Before Getting Started

e You will need to use Internet Explorer for Discoverer.
e Discoverer requires the same version of Java needed to access RIFANS. If you are having
issues with your version of Java, contact the DolT help desk at ent.servicedesk@ri.gov

Logging In

'@ lll] http://rifansap.doit.ri.gowTT78/discoverer/plus

Start by going to:

http://rifans.enterprise.ri.gov:8888/discoverer/plus?connectionAcc
essType=APPS

Remember to add the site to your Favorites!

File Edit View Favorites Tools Help

ORACLE Discoverer Plus

Connect to Oracle Bl Discoverer

s oV In the Connect To drop-down box, check to make sure
Connect Directly . . .
Enter your connection details below to connect directly to Oracle Bl Discoverer. oraCIe Appllcatlons IS Chosen

* Indicates reguired field. /—
Cmem = Enter your RIFANS username and password

= User Hame
* Password | In the Database field, type “prod”
= Database prod
Evitjser Layee Press the Go button
Responsibility |

Locale Locale retrieved from browser « I

(o) €

2010 Cracie Carporation. Al righes resened
tscouerer Plus Warslon 111170

verryouwrecuoncu—wowrd0SE a level of responsibility.


mailto:ent.servicedesk@ri.gov

File Edit View Favorites Tools Help

ORACLE  Discoverer Plus
Business Intelligence

Account Details: Select Responsibility

Maore than one Responsibility exists for the account you have chosen. Please select the one you wish to use below. .L'Eng al) ( Continue |

Responsibility
Select a Responsibility.

Locale English {United States)
Database User Mame ksimpson
Database prod
Cennection Type APPS

Responsibiity | g Financial Inguiry -

(Cancel ) | Continue

Select Rl Financial Inquiry and press Continue

Workbook Wizard

rm
=
T

| 2 Workbook Wizard - St

From this screen, you can: CreateRipes Wortbook

Connected to the Database: PROD (EUL:EUL_US)

e Open an Existing Workbook

wihat do you weant to do?

(=) Open an existing workbook
Recently Used:

To access inquiries already
There are no recently used workbooks. Browse...

developed
(see next page)

.
(_) Create a new workbook
Select the objects to display in the worksheet

e Create a New Workbook s E"

To begin creating an inquiry
from scratch
(skip to page 5)

(O crosstab () Table
Graph

Placement: | Graph below Table i ‘ ’E‘

Text Area

Cancel




Open an Existing Workbook

From the main Workbook Wizard screen .| Open Workbook from D

Choose a target worksheet by browsging available workbooks and selecting a worksheet

View: | All Workbooks. = |% ~ | Name contains: | | Clear
Workbooks:
Name =

(seen on previous page), select Open an

Existing Workbook, and press Browse. This
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[»

is where saved workbooks will appear for

future inquires

OMB and Accounts & Control have pre-

loaded a sample payroll inquiry into

4]

trainees’ Discoverer accounts. Select the

Description
Mo dezcription available

Agency Payroll Overview by Pay Period

file, and click Open S

Edit Parameter

Va I u es Select values for the following parameters:

Agency Number (three digits)® | 058 |
For this sample inquiry template, Fiscal Year (two digits]: [1a |
Discoverer asks for the three-digit
agency number (all agency numbers
begin with a zero), and the two-digit

. Description
Flscal Year. Mo description available
. * indicat ired field.

Enter the necessary data and click OK —— ~

| Help | 0K ‘ | Cancel

(T2 : | = | .
it L Pogres — The system will take a few seconds to process
Running Query... . . .
VIIIIIIIIIIIIIIII Your request. The size of your inquiry and the
Epeatianme A0 00.0: <€ nhumber of other individuals logged-in to
| Cancel . . . . .
Q Discoverer can influence processing timeliness.




Workbook

When inquiry processing is complete, your workbook will appear.

The provided Agency Payroll Overview by Pay Period workbook displays agency overall
payroll, broken down by biweekly pay period. The data fields on this sheet include:

Fiscal Year, Agency Number, Pay Period End Date, Regular Wages, Overtime Wages, Retirement Contribution, 401k
Contribution, Health/Dental/Vision Insurance Contribution, FICA payment, Assessed Fringe Benefit, Health Insurance
Cashout, Retiree Health Contribution, and Non-Classified Limited Position Salary Payments.

See descriptions of the various data sets on page 5 and the Data Field Dictionary file for data field definitions.

,_9;" http://rifansap.doit.
File Edt Wiew Format Tools Help

€USSE T.DDu 9 nE= T.% &

V.4 8

B £ U & 0 BB B
Available ftems: ¥ Fiscal Yr| ¥ Agency| F Pay period end date | » Reg Wages Nat 611000 SUM | » Overtime Nat 614100 SUM | ¥ Retire Ers Nat 620100 SUM | ¥ Tiaa 401a Nat 620110 SUM | » Health Ins Nat 6
2 s % EL 208 14 068 29-JUN-2013 §1,711,792.84 §31,251.69 §359,677.23 516,981.89 i
b 14 068 13-JUL-2013 §1,706,972.68 524,100.66 §380,546.64 516,843.41 3
m 14 068 27-JUL-2013 51,710,880.62 $31,110.80 §391,210.30 §16,972.23 g
e 14 068 10-AUG-2013 §1,723,315.48 $40531.27 $394,236.20 $17,103.48 E
List |E] RI Payroll All Agencies b/ || S ‘ 14 068! 24-AUG-2013 51,718,797 .91 $31,459.16 5393 487.07 $17,071.03 E
£Had Rl Payrol Proc Alocafion Agency. |3 14 068 07-SEP-2013 §1,726,049.53 §32244.78 §395,715.08 §17,167.66 3
i | 14 066 21-SEP-2013 §1,722,034.37 §35,511.86 §395,071.18 $17,138.71 g
/Ly Fiscal ¥t 14 068 05-0CT-2013 51,715,462.04 $34,971.65 $393,502.90 $17,071.70 g
&« gy Fund 14 068 19-0CT-2013 §1,713,214.25 $31905.17 $393,005.19 §17,050.09 E
B/ _gh Agency 14 068 02-NOV-2013 §1,716,769.70 $30,363.06 §393,727.26 517,081.39 3
[+ g4 Line seq 14 068 16-NOV-2013 §1,715,376.67 $31,704.36 5393,566.99 §17,074.46 3
B« [gh Acet source 14 066 30-NOV-2013 §1,732,720.33 526,397.43 §397,540.73 §17,237.76 g
- [ Legacy account 14 068! 14-DEC-2013 51,741,082 61 $40,793.07 $399,621.24 §17,337.09 E
& - [ Type payment 14 068 28-DEC-2013 51,746,001 72 $28,005.86 $400,561.17 $17,377.89 E
[y Pay period end date 14 068 11-JAN-2014 §1,740,724.48 $40,325.63 5389,118.30 $17,315.35 3
T e e 14 066 25-JAN-2014 51,762,427.64 531.944.47 5404,329.21 §17,406.62 g
it 14 066 08-FEB-2014 §1,754,426.21 5$31,464.03 5402,828.75 §17,328.43 g
[ Ly Employee first name 14 068 22FEB-2014 51,736,984 50 53428573 $398,896.05 $17,305.67 E
B - Ly Union desc 14 068 08-MAR-2014 §1,743,131.23 328,184.84 $400,245.10 §17,344.44 3
E: ey Wages Nat 611000 14 068 22 MAR-2014 §1,746,063.18 §32,458.80 $400,567.55 $17,378.15
E eferred Pay Nat 611001 14 068 05-APR-2014 $1,733,440.60 547 701.41 5397,719.77 §17,254.61 g
B onel Lim Nat 612000 14 068, 19-APR-2014 §1,736,054.32 $26,709.28 $398,329.68 $17,281.10 E
B vertime Nat 14100 = 14 068! 03-MAY-2014 §1,731,341.82 528,222 60 $397,223.96 $17,233.17 E
il T Dl 14 068 17-MAY-2014 §1,731,830.51 526,699.70 $387,315.03 §17,237.08 3
14 066 31-MAY-2014 51,836,585.81 $12,137.71 5420,804.56 §18,256.13 g
14 066 14-JUN-2014 §1,757,671.81 §15,840.25 5401,586.06 §17,422.43 g
Selected ftems:
t /&1
-1y Fiscal ¥r
-Lgh Agency
1 g Pay period end date
~_¥ Reg Wages Nat 611000 SUM
;{; Overtime Nat 614100 SUM
-[% Retire Ers Nat 620100 SUM
% Tiaa 401a Nat 620110 SUN
-[% Health Ins Nat 624110 SUM
L% Dental Prescr Ins Nat 624120 SUM (
-L§ Vision Ins Nat 624130 SUM
% Fica Nat 621110 SUM
‘{; Assess Frng Ben Nat 626100 SUM
~L_% MNoncl Lim Nat 612000 SUM
~L% Health Cashout Nat 616200 SUN
-} Retheatth State Nat 626300 SUM
- Agency = Agency
- Pay period end date < Pay Period End Date | | ] v
[ sheet 1

Add additional data fields:

Select other data from the

RI Payroll All Agencies list,
right-click, and select

Add to Worksheet

Remove data fields:

Select the category from the
Selected Items list, right-click,
and select Remove from

Worksheet



Payroll Data Sets

RI Payroll Proc Allocation Agency
Includes RIFANS account numbers and relevant payroll expenditures (e.g., overtime,
401k contribution, health insurance contribution by natural account, etc.)
Expenditure data only - data regarding the actual hours employees worked or
disbursed.
0 Note: this data set includes payroll as processed and does not reflect later

adjustments (so it may differ from General Ledger transactions)

RI Payroll Proc Allocation Distribution Agency

This includes the same data as the Click the plus (+) symbol in front of each
data set, to see its available components.

RI Payroll Proc Allocation Agency. The

difference is it is the dollar allocation for the toms |CoRGRRT] (CacE]

account splits for the employee. To determine st [P RPavolAtagences  ~|[ ¥ |

{j RI Payroll Proc Allocation Agency

how expenditures were funded, include the 1 Ri Payrel Proc Allocation Distribution Age
’ {j RI Payroll Processing Agency Version.

: : i
Rifans chg fund and Rifans chg agency data D S e gy

fields.

RI Payroll Processing Agency Version
Includes hours worked, vacation, personal, sick,

overtime, etc., as well as payment, union, and

class code data. **Note: best option for doing | [T

analysis of overtime data.

RI Payroll Legacy Xref by Pay Period
Includes Legacy Accounts and shows the accounts to which payroll expenditures

were charged (if expenditure was charged to several accounts).



Exporting to Excel

To do in-depth data analysis, you may wish to export your workbook to Microsoft Excel.
To export, click the icon circled here

Edit View Format Tools Help

YOS T.0OM 9 ni= % % &.%.70 4 )

A B: U E==E» ¢ 2w BB B

]

Available tems:

— o - o

¥ FiscalYr| b Agency| ¥ Pay period end date | » Reg Wages Nat 611000 sur.'l] b
- | T wsiia o I T I

Create a New Workbook

Now that you know the basics, you can create your own custom Discoverer workbook!
Begin a new workbook, start at the main Workbook Wizard screen that appears when
logging into Discoverer, or click the button circled here.

|| £ Workbook Wizard - Step 1 of 5: ¥

Worksheet Layout

Select the ohjects to display in the worksheet
[ 1ite Example
D Page tems

() Crogstab  (3) Table
[l graph

|:| Text Area

Step1

v

| Help | ‘ ﬂext>]| FEinizgh || Cancel |

From the main Workbook Wizard screen, choose the objects you wish to
have displayed on the worksheet. For this example, all objects have been
un-clicked, and Table has been chosen as the display format. After you

have chosen the objects to be displayed, press Next.




Select Items

To add tems to your worksheet, select them from the Available list and move them to the Selected list.

Auvailable Selected | B |

List | @ Rl Payroll All Agencies 'I |§|

O m Payroll Proc Allocation Agency |54
Hm Payroll Proc Allocation Distribution Agency

= ] Payroll Processing Agency Version. =
- Lﬁ Fiscal ¥r |§J
- - [g Fund L 4
i3 [gh Fund desc

- - [gh Agency

g [ﬁ Agency desc
3

i

3}

3]

Step 2

7 E;-':, Line seq
' i_& Line seq desc
L& Acct source

e A OO o T o O A o fr  w

- [ gh Acct source desc

oo ]

Mo description available

| properties.. || snowsar. | | <Back || mext> | [ fFmish || cancel |

To access payroll data from the screen above, you must first change the

- List to Rl Payroll All Agencies. You may now choose the payroll data set(s)
and data fields you wish to include in your inquiry.

See descriptions of the various data sets on page 5 and the Data Field Dictionary file for data field definitions.

Available Selected
[ tems | Conditons. || Calculations | L Fiscal Yr
— ~[gh Agency
List: | @ Rl Payroll &Il Agencies b | | QP | I:n":l Program Desc
ﬂ RI Payroll Proc Allocation Agency = L;':, Sub Program Desc
&1 RI Payroll Proc Allocation Distribution Agency |5 ~Lgh Pay period end date
El'ﬂ Rl Payrell Processing Agency Version. ’. \ I_}'_. Standard hrs SUM
SRR i o) v r < 4 ) - % Scheduled hrs SUM (
- - g Fund T || L% vachrs wki 5UH

L Sick hrs wk1 SUM
NL Ovt hrs wk1 SUM
Wac hrs wk2 SUM
ick hrs wk2 SUM
hrs wk2 SUM

i - g Fund desc
]J_'_g':, Agency
i '_E Agency desc

: !__;ﬁ Line seq desc

[

[

[

B [gy Line seq
i

[

[

2
- [gh Acct source
-

- [gh Acct source desc -

o

Highlight the fields to be included in your workbook, and press the arrow button to move
them to the Selected box. When you have finished your selections, press Next.

For this example, we will use the Rl Payroll Processing Agency Version data set, and select

Agency, Program, and Sick/Vacation/Overtime hours (weeks 1 and 2).

Tip: The Ctrl button will allow you to move multiple data fields to the Selected box simultaneously



Table Layout

To change the lsyout of information in your worksheet, click and drag the column headings to the location you wart. To change
format settings, click the ‘Properties .. button.

D?’Snuwrl’gge’ ke}rﬁ |:| Hide Duplicate Rows
Fiscal Yr | Agency | Program Desc | Sub Program Desc | Pay period end date | Standard nrs UM | Schedulec

EFFRFEEFRE

HEEE

<
n

[»]

| properties.. || snowsaL. | | <Back || wext> || Einsh | [ cancel |

Column order for your workbook can be modified on the Table Layout screen by dragging
the column headings. Discoverer auto-displays columns in the order in which they were

chosen on the previous screen. When you’re ready to continue, press Next.

Note: Column order can also be modified in the actual workbook

— BT e
orkbook Wizard ;. X ,E
i o
Sort
Click &dd and then select & column to sort. Select the Group sort type to hide repested cell values in 2 column. Check Hidden to hide a
=arted calumn in the worksheet
J Column Direction Sort Type | Hidden | Add
Sort by !] L Pay period end date ¥ | Low to High || Normal v] | |:Dem
[;3 Agency [~ = =
(g1 Fiscal vr il
L% ovthrs wki Sum
% ovthrs wk2 SUM :
St 4 L7 Pay period end date
ep L Program Desc
% Scheduled hrs SUM
% sick hrs wiki SUM |
Help | Propertes... | | showsaL. ] | <Back | Next- | | Ensn | [ cancel ]

To sort your workbook using data in a particular column, click Add =
and choose the column, direction, and sort type you’d like to use.
When complete, hit Next.

For this example, we will sort by Pay period end date, Low to High.



The last step in developing an inquiry is creating one or more Parameters. The
Parameters will tell Discoverer how you want to search through payroll data.
For example, do you want to pull up all data for a particular Agency, RIFANS
Line Sequence, Class Code, or something else?

Note: Discoverer requires at least one parameter to run an inquiry.

o= 2 Bl
|| Workbook Wizard - Step 5 of 5: )
i
Parameters ||
|
Create a parameter to prompt users to select or type & value. Click Mewy to create a new parameter. To change the current value of &
parsmeter, select Parameter Values.. ! from the Tools menu.
Available parameters:
New...
Step 5
Click New to create a new parameter.
Description
Mo description available
Start creating a Parameter by clicking New.
[ nep | | properties.. || showsaL. | [ <Back | | mnish | | cancel |

This screen will appear:

Li’.l New Parameter

VWhat do you want to name this parameter? What properties do you want to give this parameter?

|Agency Mumber Require users to enter a value

o :
Which item do you want to base this parameter on? b Ut e € il dalics

L;:‘ Agency

What default value do you want to give this parameter?

183

Create condition with operator: |=

Condition: |\}' (Agency = Agency Number)

VWhat prompt do you want to show for thiz parameter?

| Pleaze enter the three digit agency number

VWhat description do you want to show for thiz parameter?

|Agency numbers all begin with a zero |

Do you want to allow different parameter values for each worksheet?

(3] Allow only one set of parameter values for all worksheets.

_' Allow different parameter values for each worksheet.

Help | oK i Cancel |

On this screen, you will indicate what data field(s) you wish to base an inquiry’s
Parameters on. Name the parameter, choose the item, write a prompt for the
system to ask the user, and write a brief description of the parameter for the
user to reference. When you finish, press OK.

In the example above, we are telling Discoverer to ask the user which agency’s
data they wish to explore



|| 4, Workbook Wizard

Parameters

Create a parameter to prompt uzers to select or type a value. Click Mew to create & nevy parameter. To change the current value of a
patameter, select 'Parameter Values. ! from the Tools menu.

Available parameters:

Order| Mame W

Step 5
(cont.)

Description
Agency numbers all begin with a zero

| roperties... || Show QL. I

You may wish to create multiple Parameters, to make your inquiry more specific to
your needs. To add another, click the New button again.

£y _N-ew Para

What do you want to name this parameter? What properties do you want to give this parameter?

| Fiscal Year Require users to enter a value

7 .
‘Which item do you want to base this parameter on? BT RIS R LSRR

[E;'g Fiscal Yr

What default value do you want to give this parameter?

|[%]

Create condition with operator: |=

Condition: |Y (Fiscal ¥ = :Fiscal Year)

What prompt do you want to show for this parameter?

| Pleaze enter the two digit fiscal vear

What description do you want to show for this parameter?

Do you want to allow different parameter values for each worksheet?

@ Allow only one set of parameter values for all worksheets.

O Allow different parameter values for each worksheet.

Again, indicate what data field(s) you wish to base this inquiry’s Parameters on. Name

the parameter, choose the item, write a prompt for the system to ask the user, and

write a brief description of the parameter for the user to reference. When complete,

press OK to return to Workbook Wizard and click Finish.

In our example, we tell Discoverer to also ask the user which Fiscal Year data to explore
10



The Workbook
t‘|g| Edit Parameter‘u’_ | E .~.

Select values for the following parameters:

Please enter the three digit agency number®: | 062 |

Please enter the two digit fiscal year®: | 14 |

De=scription

* indicates required field.

| Help | 0K _” Cancel l

Almost done! In the Parameter Values box, enter information about what
information you are interested in, and press OK.

The system will take a few seconds to process your request. The size of
your inquiry and the number of other individuals logged-in to Discoverer

can influence processing timeliness.

To learn how to add or remove data from the workbook, refer to page 4.

To learn how to export the workbook to Excel, refer to page 6.

Notes:

° Because there are instances of multiple employees with the same name, inquiries of
payroll data with employee names should include Ssno unique nbr in the data set. For
privacy and security reasons, Discoverer does not contain actual Social Security Numbers.

. In the RI Payroll Processing Agency Version dataset, all employee sick, vacation and
personal hours discharged in a pay period are recorded in week 1 of that period. Payroll is
exploring if these hours can be correctly recorded in the week they were discharged.

11




Saving a Workbook

Discoverer allows you to Save an inquiry, and re-run it at your convenience.

ail‘.h;t@:iﬁmsap.tn Jov: 7

To Save: Fie Edi Wiew Format Toole Help

2 5& .o

\

Click the floppy disc icon on the toolbar, and follow
the prompts. See page 3 of this guide for instructions
on opening a saved inquiry. Make sure to give it a
unique name!

If you make modifications to an existing inquiry, and wish to save these
changes without overwriting the original, choose Save As.

e

ov:7

= hitp://rifansap.doit.n.g

TO Save AS: jil-® Edit View Format Tools Help
/ New . e BT
Open... Ctrl0 —
Click File > Save As... Close i
Save Cirl-5
and follow the prompts. o
Export...
Export to HTML ]
Export to Excel Il | !

Share... (

Page Sefup...

Print Preview
Print... Cirl-p

Workbook Properties...

Exit

To Share an inquiry with another Discoverer user, click File = Share...
and follow the prompts

If you have any questions about creating Discoverer inquiries, please contact Peter Hodosh in Accounts
and Control (Peter.Hodosh@doa.ri.gov) and Kevin Simpson in OMB (Kevin.Simpson@omb.ri.gov).

12
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